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“Christmas in January,” as president 

Neal Shipley termed it, got underway 

with a blessing by Verne Langley. Then 

the feasting began. Between members 

and their guests, there were 40-some 

people in attendance. And the food was 

plentiful and varied. 

 After everyone’s tummies were 

full the business meeting was called to 

order with approval of the minutes 

published in the newsletter. Myron gave 

a report on the state of the treasury for 

both November and December and both 

reports were approved. 

 On a question by one of the 

members present, Neal reported that it 

had been decided to go ahead and pay 

the regular rent for the hall even though 

we did not have a meeting in December. 

 One of the items in Myron’s 

report was a donation to the computer 

lab which will be put to good use later 

this month. 

 A mention was made of the 

death of Francis Vargas’s daughter and a 

card was passed around for the 

members present to sign. 

 Neal thanked Joe Fornero and 

Tom Cartwright for taking over the 

November meeting in his absence. He 

then proceeded to take nominations for 

officers to be voted on at the February 

meeting. Nominated for president was 

Joe Fornero, Betty Beatty for vice 

president, Myron to remain as treasurer 

and Angela as secretary. Also to be voted 

on will be several members-at-large for 

the board, Art Bendick, Kent  McNeill 

and Joe Schmitt 
 

 Terry announced a new class to 

be held on Windows 7 because, as he 

said, most of the people who want to 

learn to operate a computer have 

Windows 7 and not an older version. 
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U S E R  H E L P I N G  U S E R  

 At the February meeting Art 

Bendick will present the program, which 

he normally would have done in January, 

related to whatever he has included in the 

DVD he usually loads up every year. 

 Neal said that although he will no 

longer be president, he will continue the 

raffles if the membership wants them. He 

then asked for a show of hands in favor or 

against continuing with the monthly 

raffles. An overwhelming majority of those 

present raised their hands in favor of 

continuing with the raffles, but it was 

suggested that maybe the number of 

items being raffled could be cut down. 

 Betty commented that Joe is 

doing a great job with the newsletter and 

everyone agreed with her. 

 Terry then reminded the 

members that the committee to revise the 

by-laws needs to get together to do so. 

 Glenda MacLennan took the floor 

then to announce that she will put 

together a bus trip to Orlando to visit 

“Little Jerusalem.” She will arrange all the 

transportation, overnight stays and 

insurance for the trip and, with advertising 

through churches in the area, maybe 

there would be as many as three buses 

going. Any profit from the trip would go to 

the club. 

 A motion was made to adjourn 

and Santa Joe took over for fun and 

games. 

 And fun and games it was with 

Santa Joe’s presentation of music for us 

oldsters. Everyone ended up with at least 

one gift from the two tables full of all sorts 

of items, from computer related to bottles 

of perfume. 

 Thank you again, Santa Joe. 

Respectfully submitted by  

Angela V. Rester, secretary 
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Boy oh Boy, you try to be nice 

to the club by playing Santa 

Joe and the next thing you 

know I’m nominated for 

President, again.  I’m suppose 

to go back to the North Pole for 

some much needed R & R. 

 

Well I did it before and I guess 

you didn’t object to strongly, 

but that was 5 years ago.  So if 

you must and if you vote me in, 

I’ll serve a one year interim 

term as President with Betty as 

my VP to take over in 2012.  

[Actually Betty says, if elected 

VP, she will see how 2011 

goes before committing to 

anything for 2012.]  We will be 

voting on new officers at the 

February meeting and nomina-

tions for all positions will be 

reopened, before the vote.  

 

I think the club is in good 

shape and Neal has done an 

excellent job as President the 

last 3 years. If you agree be 

sure to thank him personally at 

our next meeting. If fact you 

should thank all the board 

members for their service.  

 
The raffle’s main prize this 

month will be a player that 

plugs directly into the power 

outlet in your car and can play 

MP3’s from a SD flash drive or 

through a USB cord from 

another device. 

  
Joe Fornero—Editor 

F E B R U A R Y  N E W S   

U S E R  H E L P I N G  U S E R  

The  January board meeting 

was held at the home of 

president Neal Shipley with 

Joe Fornero, Myron 

Kliment, Art Bendick, Tom 

Cartwright, Terry 

MacLennan and Angela 

Rester also present. 

 Neal announced that 

Eric Arduini will be giving 

the program on March 12, 

he has a local computer 

repair business and we 

have left the program up to 

his discretion. 

 Terry brought up the 

subject of the by-laws 

revision and it was decided 

that the committee, which 

is composed of Art 

Bendick, Jim Wells, Joe 

Fornero, Joe Schmitt, Terry 

MacLennan, Tom 

Cartwright and John Miller 

will meet on Jan. 29 at the 

Whiteside Senior Center at 

10AM if the majority of the 

members of the committee 

are available. 

 Neal was drafted as 

the “mouse tech” for the 

coming general meetings. 

B O A R D  M E E T I N G  M I N U T E S  F O R  

J A N U A R Y 1 1 ,  2 0 1 0  

 Volunteers are 

needed for program 

presentations. Just let 

someone on the board 

know if you are willing to do 

a program presentation. 

 Terry is working on a 

power point presentation on 

Windows 7 for the March 

6th “Hamfest” meeting  at 

Challand School. They will 

be providing us a table to 

promote our club and a 

couple free tickets.   

 The meeting was 

adjourned until February. 

  

Respectfully submitted by  

Angela V. Rester, secretary 
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temporarily disable the touch-

pad when you type, you might 

be able to find a “Touch To 

Click” option. Disabling this op-

tion should fix the problem, but 

you’ll no longer be able to tap 

your touchpad to left-click. 

You’ll have to use the mouse 

buttons above or below your 

touchpad instead. 
 

Q When I try to eject my thumb 

drive by clicking the Safely Re-

move Hardware icon in the Win-

dows System Tray, I get a mes-

sage that says the device is cur-

rently in use. How can I safely 

remove my thumb drive?  
 

A It’s always a good idea to 

“eject” any removable media 

before physically removing it. 

By “ejecting” the media before 

physically removing it, you’re 

telling Windows not to access 

the drive and avoiding the risk 

of accidentally corrupting data. 

You generally eject media by 

right-clicking the Safely Remove 

Hardware And Eject  Media icon 

in the Windows System Tray 

and clicking Eject. Usually, you 

receive a message saying it’s 

safe to remove your media, but 

occasionally, you get a mes-

sage stating that the device is 

in use and cannot be stopped. 

This usually happens when an-

other program is accessing your 

thumb drive. In order to safely 

remove it, you need to shut 

down the application or process 

that is accessing the thumb 

drive.  

Start by making sure that no 

files or folders on the thumb 

U S E R  H E L P I N G  U S E R  

drive are being displayed on the 

PC and close any that you find. 

For instance, you won’t be able 

to eject the thumb drive if you 

have a Word document or pic-

ture file open on your system. If 

the drive is still busy, close all 

open applications. Some appli-

cations may create temporary or  

backup files and store them on 

your thumb drive. Just closing 

the file may not be enough to 

remove the backup file; you may 

have to close the application 

itself.  
 

If you’re still having problems, 

make sure that you don’t have 

any software that is scanning 

the drive. 

Antivirus or anti-malware appli-

cations, for instance, may scan 

removable drives, and any re-

movable drive will not be able to 

be removed while the scan is 

being conducted. 

Finally, you can always shut 

down the computer. The danger 

of data corruption comes when 

you suddenly remove the media 

while it’s being accessed. By 

shutting down the computer, 

you’re closing down all your ap-

plications, including any applica-

tion that’s accessing your thumb 

drive. This graceful shutdown 

should prevent any data dam-

age. Once the computer has 

shut down, you can remove the 

media from the system. 

Each month, we receive numerous tech-

nical support calls and email messages. 

Some  computer problems are fairly 

common, and we find that many  

callers struggle to resolve the same is-

sues. In this article, we cover some of the 

most common or timely tech support  

questions and provide our solution for 

each of them. 
 

Q I recently upgraded to a lap-

top with Windows 7. Occasion-

ally, when typing in a docu-

ment, the cursor jumps 

around, and I end up inadver-

tently typing elsewhere in the 

document. What can I do to 

stop this? 

A Most likely, your fingers are 

grazing your notebook’s touch-

pad. When this happens, the 

cursor jumps to the location of 

your pointer. Many touchpad 

drivers have a setting that tem-

porarily deactivates the touch-

pad when you type. Enabling 

this feature should help solve 

the problem. 
 

On most systems, you can ac-

cess your touchpad’s settings 

by right-clicking the touchpad 

icon in the Windows System 

Tray and click Properties. De-

pending on your system, you 

may also find your touchpad’s 

settings available in the Start 

menu. You’ll have to look 

through the settings to find the 

appropriate option, as the ex-

act location and wording will 

vary depending on the driver. If 

you don’t see an appropriate 

option, you can check with 

your system manufacturer to 

see if an updated driver is 

available.  
 

If you can’t find an option to 

N E W S  F R O M  T H E  H E L P  D E S K  

C O M P I L E D  B Y  C H A D  D E N T O N  
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U S E R  H E L P I N G  U S E R  

N E W S  F R O M  T H E  H E L P  D E S K ( C O N T . )  

Q When I start my computer, I 

hear a series of beeps, and 

Windows refuses to load. How 

can I fix my computer? 
 

A When you first start your com-

puter, it performs a quick hard-

ware check. If a component isn’t 

functioning correctly, your com-

puter will make a series of 

beeps.  

 

Unfortunately, beep codes aren’t 

standardized, so you’ll need to 

check your system manual to 

determine what these codes 

mean. If you don’t have a hard 

copy of the manual, you’ll need 

to use a working computer to 

access your manufacturer’s Web 

site where you should be able to 

find an online version of the user 

guide. The test can catch a 

broad range of problems. In 

some instances, you may need 

to simply remove or replace 

RAM. In other cases, you may 

need a new motherboard or 

processor. 

 

Q  I have a computer with two 

SATA (Serial Advanced Technol-

ogy Attachment) drives. One 

drive contains Windows XP, 

and I want to add Win7 to the 

second drive. Will I still be able 

to boot into WinXP with this 

setup? Is there anything else I 

should be concerned with? 

 

A In order to dual boot between 

operating systems, you generally 

need two physical hard drives or 

one physical hard drive parti-

tioned into multiple virtual 

drives. In this setup, there’s al-

ready two separate drives 

(whether they are physical drives 

or virtual drives), so you’re half-

way there.  

 

If dual booting between different 

versions of Windows, always install 

the newest OS (operating system) 

first. The newer version of Windows 

will scan the system for older ver-

sions and set up a boot loader that 

will let you choose which version you 

want to boot at startup. 

 

One note of caution: It’s generally a 

good idea to reformat the hard drive 

on which you’ll install Windows. This 

will erase any existing data, so make 

sure you back up any data on the 

drive. 

 

Q When I try to save a file from 

Gmail to My Documents, I get an 

error message saying I need to ac-

tivate cookies. What does this 

mean, and how I do activate cook-

ies? 

 

A Cookies are very small files that 

can be used to store a variety of in-

formation. For instance, Gmail Cook-

ies may contain session information 

that Gmail can use to automatically 

log you in the next time you visit 

from the same PC. Although cookies 

generally make life online easier, 

they can also be used, mainly by 

online marketers, to track your Inter-

net habits.  

 

If you decide you want to enable 

cookies, you’ll need to do so in what-

ever browser you’re using. In Inter-

net Explorer, cookies are controlled 

by Internet Explorer’s Privacy Set-

tings. Click Tools, open Internet Op-

tions, and click the Privacy tab. If 

you don’t want to adjust all your Pri-

vacy settings, click Advanced and 

place a check next to Override Auto-

matic Cookie Handling.  

Select Accept under First Party 

Cookies. You may wish to select 

Block under Third Party Cookies (this 

is a good way to prevent online mar-

keters from monitoring you too 

closely). Finally, you can place a 

check next to Always Allow Ses-

sion Cookies if you want to allow 

cookies that automatically log 

you in to sites.  

 

In Firefox, Click Options in the 

Tools menu and click Privacy. In 

the drop-down menu under His-

tory, select Use Custom Settings 

For History. Make sure there’s a 

check next to Accept Cookies 

From Sites. If you want, you can 

remove the check next to Accept 

Third-Party Cookies.  

Firefox screen shot: 

Finally, in Google Chrome, click 

the wrench icon and select Op-

tions. Click the Under The Hood 

Tab and then click the Content 

Settings button. Make sure to 

select Allow Local Data To Be 

Set. Again, you can select Block 

All Third-Party Cookies Without 

Exception to block third party 

cookies.  

 
Reprinted with permission from 

Smart Computing. Visit 

www.SmartComputing.com/groups 

to learn what Smart Computing can 

do for you and your user group! 
 

 
 

 

 

 

http://www.smartcomputing.com/groups/Default.aspx?guid=b0d0a609520d4f12a7e9df5c5e4bee6e


U S E R  H E L P I N G  U S E R  

What a terrible name!  

Often confused with  

Internet Explorer, this file 

manipulator is one of the 

most useful and used 

programs on my com-

puter. I often talk with  

people who don’t know 

what this program is. 

They have never used it, 

and I am curious as to 

how they can accomplish 

anything with their com-

puter without familiarity 

with this powerful utility.  
 

Here’s what it does: 

Windows, as with most 

operating systems, is 

based upon a file struc-

ture where each program, 

picture, song or  

document is stored in a 

named file in some mem-

ory device, e.g., a hard 

drive, CD, DVD or flash 

drive. Groups of similar 

files are stored in named 

folders. Windows Explorer 

is a file manipulator al-

lowing you to find, copy, 

move, save, launch, and 

a variety of other opera-

tions on individual and 

groups of files. 
 

A quick way to launch it is 

to right click on the Start 

button and select Explore 

from the sub-menu. A 

better way in XP is to place 

an Icon for Windows Ex-

plorer on your desktop. To 

do this, first locate the  

program: Start/All pro-

grams/Accessories/

Windows Explorer; then right 

click it and in the drop-down 

menu select “Send to/

desktop (create shortcut)”.  
 

I don’t like the Icon view; I 

prefer the Details view with 

no Icons and more informa-

tion. The Details view allows 

you to sort the filenames by 

alpha ascending (A to Z) by 

clicking on the Name in the 

gray title bar. Clicking Name 

a second time will sort the 

file name alpha descending 

(Z to A). Sorting by Size, Type 

(file  

extension), or Date Modified 

is done the same way. Under 

Tools/Folder Options/View 

tab, be sure to uncheck 

“Hide extensions for known 

file types” and check “Show 

hidden files and folders.” 

Then click the “Apply to all 

folders” button to set all 

views to the same settings. 

Windows 7 recognized the 

importance of this program 

and keeps it on the taskbar 

for easy launch. It is a yellow 

file folder Icon, third from 

the left Start button. 

 

An easier application of 

Windows Explorer is to 

bring up two copies, re-

sized and located so you 

can see both side by side. 

Then you can easily Move 

or Copy files between the 

two windows using d-d 

(drag and drop). By default 

files d-d to the same drive 

are Moved; files d-d to  

different drives are Copied. 

Holding down the left 

mouse button during the   

d-d allows you to select ei-

ther option. To add new 

folders or subfolders use 

the menu File/New/Folder 

command.  
 

A good site to visit to learn 

many more features of 

Windows Explorer is: 

http://www.toejumper.net/

speed5/winex5.htm 
 

Familiarize yourself with 

this powerful program so 

you can control your  

computer, and not have 

your computer control you! 
 

By Wil Wakely, President,  

Seniors Computer Group, 

California 

Bits & Bytes, June 2010 Issue 

www.scg.org / wilw@adnc.com 

 

This article has been obtained from AP-

CUG with the author’s permission for pub-

lication by APCUG member groups; all 

other uses require the permission of the 

author. 
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U S E R  H E L P I N G  U S E R  

Microsoft Excel 2007 
Text Alignment Tricks by Trevor Meers 

   Because Excel is built to  

handle numbers rather than 

words, formatting text in your 

worksheets can get a little 

frustrating. When your 

text is wider than the column 

it’s in, you run into strange 

truncations of the words. 

When your text sits on the left 

side of columns while numbers 

sit on the right, it just doesn’t 

look right. If you’re running  

into these and other text  

problems, use this month’s 

tricks to get the look you need. 
 

Wrap Text 

   The text issue that probably 

gives Excel users the most 

headaches arises when you try 

to fit a lengthy piece of text 

into a cell. One solution is 

simply going to the top of the 

window and dragging the right 

column border to make it  

wider. That can lead to its own 

untidy look, though. What if 

some of the labels in a column 

listing corporate divisions are 

as short as “Tax” and others 

have names such as “Regional 

Sales-Pacific Rim/China  

Division”? If you drag the  

column wide enough to handle 

the longest labels, you get lots 

of empty real estate on the 

shorter labels. A better  

solution is leaving the column 

width at a more average size 

and setting text to wrap into 

multiple lines. Click the  

column title at the top of the 

window (such as “C”) and click 

the Wrap Text button on the 

Ribbon’s Home tab. Now every 

cell in the column will  

automatically wrap the text to 

a new line if one line of text  

exceeds the column width.  

Sometimes this still doesn’t 

make all your text visible. That 

means you probably have a row 

height issue. Excel may be pre-

venting the cell from growing  

taller to handle wrapped text. To 

ensure you don’t run into this, 

click the cell (or column of cells) 

you want to adjust, click the 

Ribbon’s Home tab, and click the 

Format button in the Cells  

section. Select AutoFit Row 

Height to make Excel expand the 

cell to handle however many 

rows of text are necessary. 
 

Align Text 

   Excel automatically places 

numbers on the right side of cells 

and text on the left. Sometimes 

that’s a handy setup, making it 

easy to scan a list and spot  

different kinds of information. 

But when you’d rather see every-

thing neatly lined up, use the 

Home tab’s alignment buttons. 

You can align text to the right, 

left, or center. (The latter being 

especially useful for making  

column headings more  

attractive.) And, of course,  

remember that you can use the 

alignment tools on numbers, too. 

   If you’ve adjusted cells’ 

heights, you may want to adjust 

the text’s vertical alignment for a 

better look, too. You’ll find those 

options on the Home tab right 

above the horizontal alignment 

buttons.  

   In rare cases, you actually may 

want text to run at an angle. 

Short column labels, for example, 

sometimes work well at a 45-

degree angle. To add an angle to 

a cell’s text, including setting 

it to read vertically, use the 

Orientation button on the 

Home tab in the Alignment 

section. 
 

Merge Cells 

   Here’s a common dilemma: 

At the top of the worksheet, 

you create a label that ap-

plies to several columns. How 

do you make this clear by 

stretching the label across all 

the columns? Dragging the 

label’s cell any wider won’t 

help, because you’ll widen all 

the cells below the label, too.  

The secret is to merge the 

label cell with those adjacent 

to it. Use the Merge & Center 

button in the Home tab’s 

Alignment section.   

   Highlight the cells you want 

to merge (they can be  

adjacent either horizontally, 

as in our example described 

above, or vertically) and click 

the Merge & Center button. 

Now you’ll have one large cell 

with the text located in its 

center. If you’d rather place 

the text on a side of the cell, 

click the cell and use the 

Alignment buttons as  

described previously.  

   Even though this large cell 

now straddles, say, three  

other columns, you can still 

adjust the widths of those  

columns individually. Your 

merged cell will grow and 

shrink so that it always fills 

the same space as the  

columns it covers.  
Reprinted with permission from Smart Com-

puting. Visit www.SmartComputing.com/

groups to learn what Smart Computing can 

do for you and your user group! 

http://www.smartcomputing.com/groups/Default.aspx?guid=b0d0a609520d4f12a7e9df5c5e4bee6e
http://www.smartcomputing.com/groups/Default.aspx?guid=b0d0a609520d4f12a7e9df5c5e4bee6e


can also use this service 

to define words (for exam-

ple "define zenith") and 

more. 

 

• Flash Drive Benefits: If 

you're like many laptop 

users, you take your  

computer everywhere. 

Portable computing 

means that your storage 

devices will undoubtedly 

absorb more abuse from 

bumps and scrapes than 

those left behind on a 

desktop PC. Some  

storage technologies 

aren't well-suited for the 

road—hard drives can 

break if they suffer a hard 

blow, and CDs and DVDs 

are easy to scratch to the 

point that you can't read 

them. That's where USB 

flash memory drives  

often shine. These drives 

are small enough to fit on 

a keychain, and they 

come in tough plastic 

cases that make them 

very difficult to damage. 
 

 

Reprinted with permission from 

Smart Computing. Visit 

www.SmartComputing.com/

groups to learn what Smart 

Computing can do for you and 

your user group! 
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If you acquired a new desktop 

or laptop computer for Christ-

mas, you won't find Microsoft 

Works anymore.  It has been 

replaced with Office Starter 

2010, which includes Word 

and Excel.  Since it is free you 

will notice some advertising 

but that's really not a big 

deal.  Your computer should 

also have preloaded a full trial 

version of Office 2010 which 

you can use for 60 days and 

then you will be asked to pur-

chase it.  If you don't want to 

use Office Starter or pay the 

high price for the full version 

of Office, an alternative is Ora-

cle's Open Office which is an 

entire office suite and is free.    

 

Here's a tip from last January's 

Cyber News.   On rare  

occasions you might find your-

self not being able to connect 

to the Internet.  Here's the 

tip:  Unplug your cable modem 

(the power cord) for 20  

seconds.  If you're running a 

router unplug it too.  Plug 

them both back in and wait 

until all the lights are lit, then 

try your browser or mail  

program again.  Nine out of 

ten times this will fix the  

problem and save you from 

calling tech support.   
 

The contents of Cyber News may be copied, 

reproduced, or freely distributed for all     

nonprofit purposes without the consent of the 

author as long as the author's name and 

contact information are included.  Cyber News 

is a free service of Stanley Computing and is 

published each month, originating from     

Stanley's Studio in Phoenix, Arizona.    

Emails To Look Out For: If 

you get an email urging you 

to update your eBay, PayPal, 

or bank account  

information, chances are it's 

false. An easy way to tell in 

Outlook is to hover your 

mouse pointer over the  

hyperlink in the message. If 

the URL reads something 

like "www.paypal.com" in the 

message, but some other 

address such as "www.vali-

dationcgi.org" shows up in 

the floating box next to the 

pointer as you hover, you 

can be pretty certain you 

should delete the email. 

Phishing emails attempt to 

get you to provide personal 

information by mimicking 

emails from legitimate com-

panies. Most companies will 

never ask you to verify  

account information with an 

email, so beware any such 

correspondence. 

 

GOOGL It: When you are 

looking for something in an 

unfamiliar area, it can be a 

real pain to figure out where 

things are. But if you send a 

text message to GOOGL 

(46645) with a search  

query, such as "Pizzerias, 

Omaha," you'll get a free text 

message right back from the 

search company, with the 

answer to your query. You 

U S E R  H E L P I N G  U S E R  

S M A R T  C O M P U T I N G  

T I P S  &  F U N  F A C T S  
Cyber News 

By Gary Stanley 

http://www.smartcomputing.com/groups/Default.aspx?guid=b0d0a609520d4f12a7e9df5c5e4bee6e
http://www.smartcomputing.com/groups/Default.aspx?guid=b0d0a609520d4f12a7e9df5c5e4bee6e
http://office.microsoft.com/en-us/starter/
http://office.microsoft.com/en-us/starter/
http://www.openoffice.org/product/
http://www.paypal.com
http://www.vali-dationcgi.org
http://www.vali-dationcgi.org
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There is a very old saying, 

"There are BOLD pilots and 

there are OLD pilots but there 

are very few OLD-BOLD pilots" 

        I'm now inclined, from a 

personal perspective, to 

strongly agree. 

        First off I would consider 

myself, although with limited 

experience (less than 200 

hours of pilot time) to be in 

that first category. 

        Although I do have some 

10 to 15 hours of LINK (a 

forerunner of flight simulator) 

trainer time which entirely de-

pended on blind flying via in-

strument usage it was my  

only experience in the use of 

tools required for hazardous 

flying conditions which I now 

feel was the main cause of 

pilot demise in the Army Air 

Corps. 

        Let me elaborate. Under 

normal flight conditions,  

especially in smaller aircraft, 

a pilot may easily fly using  

unacceptable maneuvers one 

of which is to change the rate 

of decent by tipping the  

aircraft to one side and  

slipping sideways in a some-

what controlled stall.  During 

primary flight training it was 

my custom to do just that 

even though on at least one 

of the training planes that I 

flew was a two position flap 

system. Being a BOLD, or 

maybe just a LAZY, pilot I  

never even ventured to use 

that tool. Not even consider-

ing the possibility there might 

U S E R  H E L P I N G  U S E R  

be a good reason for this added 

feature. When the time came for 

flying a larger basic trainer it was, 

along with prop pitch / radio us-

age / more instrumentation / 

(not having previously looked 

around for other aircraft enough) 

it became just one of many now 

needed exercises that in total 

was overwhelming at least in my, 

at that time, check pilot’s  

opinion. 

         Probably the final straw may 

have been when as I touched 

down the basic trainer in a fine 

three point landing I was looking 

towards the tail of our airplane. 

         Anyway, as I was going 

through the lessons of Flight 

SimX, lesson 7, to be exact, the 

flying of a sailplane towards the 

end of the flight that the only  

sensible method of reducing    

altitude required the use of 

FLAPS. My only other recourse in 

getting the aircraft down was to 

either dip down via over speed 

which I was notified a dangerous 

thing to do or circle around until I 

removed the aircraft from, in this 

case, unwanted upward inducing 

thermals. I have as yet, by the 

way, mastered the proper FLAP 

method of increasing decent but 

will keep on trying till I am       

successful.   

   

P.S. As a sequel to this, after  

returning from the Quad Cities to 

DC trip on a Boeing 737 Series 

800 jet, I was happy to find, also 

on the same program that this 

aircraft was also on its list. 

         So "taking the bull by 

the horns," I again tried  

simulating the trip to DC. This 

time I was a little more  

fortunate although I some-

how detoured via Canada 

and then arriving at Dulles 

International I landed pretty 

hard but after passing 

through a few trees did come 

to a stop but not quite on the 

runway  proper. 

         My next try will be the 

return trip back to the Quad 

Cities at night to see how 

well I might do. 

         In regards to the trip, 

I've never flown much over  

10,000 feet before my  

previous experiences having 

been in the 'ancient' type 

prop driven variety. 

         Did others note in the 

local news that small radio 

control plane flyers were  

having trouble in getting   

permission to fly again at the       

complex out on West      Le-

Fevre? I noted that one lead-

ing in the process of  continu-

ing the  hobby was a pilot 

who at one time at a com-

puter club meeting at Essex 

Computer did a presentation 

for us using an older FS pro-

gram. Maybe we could get 

him to again do a presenta-

tion. I, for one, found it quite 

interesting.              

 

WHAT FLIGHTSIMX TAUGHT ME LAST MONTH 

by Don Haag  
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When you are editing your document, there are many times that Word tries to guess what you are doing and 

then complete your task for you. This helpfulness can be aggravating at times. One such instance is when you 

are trying to use the mouse to select text from the middle of one word to the middle of another. Whenever you 

click inside a word and then start dragging the mouse, Word assumes you want to make a selection. As soon 

as you move the mouse pointer outside the word, the program assumes you wanted to select the entire first 

word in which you originally clicked. 

If you want to ensure that Word doesn’t make that assumption, you need to follow these steps to turn off the 

offending feature in Word 97 through Word 2003: 

1. Choose Options from the Tools menu. Word displays the Options dialog box. 

2. Make sure the Edit tab is selected. 

3. Make sure the When Selecting, Automatically Select Entire Word check box is cleared. 

4. Click on OK.   (See left figure.) 

You can follow these steps if you are using Word 2007 or Word 2010: 

1. Display the Word Options dialog box. (In Word 2007 click the Office button, then choose Word 

Options. In Word 2010 display the File tab of the ribbon, then click Options.) 

2. Click Advanced at the left side of the screen. 

3. In the Editing Options area, make sure the When Selecting, Automatically Select Entire Word check 

box is cleared. 

4. Click on OK. (See right figure.)  

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted  by permission.  

Thousands of free Microsoft Excel tips can be found  

  online at http://excel.tips.net. 

A U T O M A T I C A L L Y  S E L E C T I N G  W O R D S   

I N  W O R D  

U S E R  H E L P I N G  U S E R  

http://excel.tips.net


Notice 

     The next meeting of  the  Sauk                                     

Computer  User Group will be  

Feb. 12, 2011       

    Question & Answer: 1:00 PM                    

Business: 2:30 P.M.          

Program: 3:00 P.M. 

  Place: Whiteside Senior Center                                

 1207 West 9th Street                               

 Sterling, Illinois 61081 

A R T  B E N D I C K ,  O N E  O F  T H E  C L U B ' S  G U R U S ,  I S  P U T T I N G  T O G E T H E R  A  D V D  O F  M A N Y   

U S E F U L  F R E E  A P P S .   S O  F O R  O U R  F E B R U A R Y  P R O G R A M ,  A R T  W I L L  S H O W  U S  W H A T  H E  

H A S  C O M E  U P  W I T H  A N D  D E M O N S T R A T E  S O M E  O F  T H E S E  U S E F U L  P R O G R A M S .    

Sauk Computer User Group                               

User Helping User                                             

3406 E. 19th St.                                            

Sterling, IL 61081 

There will be a Question & Answer    

Session starting at  1PM. 

Bring any questions you have about 

your computer or problems you may 

be having. It will be conducted by: 

     Neal Shipley & Art Bendick 


